
Формирование новой электричес�

кой схемы начинается с создания но�

вого файла проекта и листа схемы с

помощью команд File > New > Project >

> PCB Project и File > New > Schematic.

После создания новых документов их

следует сразу же сохранить, иначе

позднее компиляция будет недоступ�

на. Для сохранения проекта выполня�

ем File > Save Project As, а для схемы –

File > Save. Присвоим проекту и схеме

название Ucheba. В результате в пане�

ли Project (см. СЭ № 5, 2008) будет

отображена структура проекта, пока�

занная на рисунке 1.

НАСТРОЙКА РЕДАКТОРА

При первом создании документа

схемы обратите внимание, что схема

открывается в дюймовой системе из�

мерения и с форматкой, не соответ�

ствующей ГОСТ. Поэтому, прежде чем

приступать к реализации схемы, необ�

ходимо настроить параметры рабо�

чей области и текущего листа схемы.

Начнём с настроек текущего доку�

мента, которые устанавливаются на

вкладке Design > Document Options. Ре�

комендуемые настройки документа

показаны на рисунке 2. Следует на�

чать с вкладки Units, на которой необ�

ходимо указать миллиметры в каче�

стве единиц измерения, при этом

настройка применятся только к от�

крытому документу (ниже будет опи�

сана процедура установки единиц из�

мерения по умолчанию). Далее на

вкладке Sheet Options следует отклю�

чить все параметры в дополнитель�

ных настройках, т.к. они в большин�

стве случаев не используются в прак�

тике отечественных предприятий.

Отдельно стоит сказать о двух пара�

метрах, помеченными знаками (*) и

(**) на рисунке 2.

Системный шрифт используется

для надписей, привязанных к некото�

рым объектам по умолчанию (напри�

мер, название и номер вывода, назва�

ние порта). При изменении этого па�

раметра на данной вкладке размер

надписей изменится во всём доку�

менте.

Электрическая сетка – это область

вокруг вывода компонента, за кото�

рую «цепляется» цепь при соедине�

нии компонентов. Значение данного

параметра должно быть минимум в

два раза меньше шага расположения

выводов условного графического

обозначения компонентов (УГО). На�

жатие кнопки ОК подтверждает вы�

бранные настройки.

В окне Document Options показаны

локальные настройки, относящиеся

к текущему листу схемы. Основная

масса глобальных настроек, кото�

рые применяются ко всему редакто�

ру и ко всем вновь созданным доку�

ментам, находится в меню: DXP > 

> Preferences > Schematic (см. рис. 3).
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Все редакторы схем похожи, однако, в Altium Designer имеется

большое количество параметров и настроек. Его отличительными

особенностями также являются проектная структура разработки

(см. СЭ №№ 5 и 6, 2008) и непривычная для разработчиков процедура

компиляции схемы и проекта. В данной статье будут рассмотрены

наиболее важные настройки и инструменты редактора схем

Altium Designer и описана процедура компиляции проекта.

Altium Designer Summer 08 –
разработка и компиляция
электрических принципиальных схем

Алексей Сабунин (Москва)
Прежде чем начать работу с редак�

тором схем в первый раз, рекоменду�

ется просмотреть все вкладки группы

Schematic (см. рис. 3) и установить оп�

тимальные настройки. Не пытайтесь

разобраться сразу во всех – уделите

внимание основным. Рассмотрим

назначение каждой вкладки и опи�

шем наиболее значимые настройки.

Вкладка General задаёт общие наст�

ройки, которые необходимо знать на

начальном этапе (см. рис. 3). На

вкладке Graphical Editing задаются

настройки редактирования объектов;

отметим наиболее важные из них.

Clipboard Reference – если эта наст�

ройка включена, то при выполнении

операций копирования (Copy) или вы�

резания (Cut) система будет запраши�

вать указание точки привязки. Это ис�

пользуется при копировании части

схемы, которую надо будет вставить

обратно в схемный лист. Указатель мы�

ши при этом будет удерживать встав�

ляемый блок именно за эту точку.

Add Template to Clipboard – при

включении этого параметра шаблон

листа будет копироваться в буфер об�

мена при выполнении операций ко�

пирования и вырезания.

Convert Special Strings – включение

этого параметра позволяет увидеть

на экране содержимое специальных

строк в том виде, в котором они будут

выведены на печать.

Center of Object – при включении

данного параметра указатель мыши

удерживает перемещаемый объект в

точке привязки (если объект имеет

такую точку) или за его центр (если

объект не имеет точки привязки, –

например, прямоугольник).

Object’s Electrical Hot Spot – при

включении данного параметра указа�

тель мыши удерживает перемещае�

мый объект в ближайшей горячей

точке (например, конец вывода).

Auto Zoom – при включении данно�

го параметра и переходе к какому�ли�

бо элементу принципиальной схемы

автоматически изменяется масштаб
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Рис. 1. Структура проекта



отображения. В противном случае

масштаб остаётся постоянным.

Single «\» Negation – при включении

данного параметра все идентифика�

торы цепей (порты, метки цепей, вхо�

ды листа), имеющие в начале назва�

ния символ «\», воспринимаются как

инверсные соответствующей цепи.

Always Drag – при включении дан�

ного параметра компонент будет пе�

ремещаться со связями, а при нажа�

той клавише Ctrl – без связей, при

выключенной – наоборот.

Display Strings As Rotated – показы�

вать повернутый текст в реальном ви�

де, в противном случае отображение

всех текстов будет слева направо.

Auto Pan Options – параметры авто�

матического панорамирования. Style:

при выборе Auto Pan ReCenter в режи�

ме редактирования компонента при

выведении указателя мыши за преде�

лы видимой области рабочего окна,

будет происходить автопанорамиро�

вание вокруг указателя мыши, кото�

рый, в свою очередь, будет разме�

щаться в центре рабочего окна. При

выборе Auto Pan Fixed Jump вид окна

будет «прыгать» за указателем мыши с

шагом, указанным в строке step size.

При выборе Auto Pan Off автопанора�

мирование будет отключено (дан�

ный режим соответствует настройке

редактора схем программы P�CAD).

Speed – скорость автопанорамирова�

ния. Step size и Shift Step Size – размер

шага при ручном панорамировании

(которое осуществляется клавишами

Scroll и Shift+Scroll).

Undo/Redo Stack Size – задаёт макси�

мальное число последовательного

выполнения команды отмены преды�

дущего действия (Undo). Group Undo –

при включении данного параметра

будут группироваться действия, вы�

полненные одной командой.

На вкладке Mouse Wheel Configura�
tion задаётся функциональность кно�

пок мыши, т.е. можно поменять кноп�

ки, управляющие изображением и

меняющие масштаб, приспособив

управление изображением в Altium
Designer под знакомые программы

(AutoCAD, SolidWorks или Компас).

На вкладке Compiler, кроме уста�

новки цветов ошибок и предупрежде�

ний при компиляции, можно устано�

вить функцию Auto�Junction, которая

включает или выключает режим со�

единения связей при наложении кон�

ца связи на уже существующую связь.

Во включенном режиме система ав�

томатически поставит точку, обозна�

чающую соединение цепей.

Вкладка Break Wire задаёт настрой�

ки инструмента Break Wire (обрезка

проводника) – устанавливает размер

отрезка (количество шагов сетки),

который будет вырезать инструмент

Edit > Break Wire.

На вкладке Default Units имеется

возможность выбрать единицы изме�

рения. Здесь следует установить флаг

в строке Use Metric Unit System, после

чего работа будет выполняться в мет�

рической системе.

Вкладка Primitives позволяет уста�

новить значения по умолчанию для

всех графических и электрических

примитивов. Для знакомства с воз�

можностями данной настройки из�

меним некоторые значения: в списке

Primitives находим наименование

Rectangle, нажимаем на нём левой

кнопкой мыши (ЛКМ) и далее нажи�

маем кнопку Edit Values. В открыв�

шемся окне мы можем полностью за�

дать базовый набор для примитива

«Прямоугольник», но нас интересует

только пункт Draw Solid, – убираем

флаг (теперь при рисовании прямо�

угольника он не будет заполняться

заливкой). Нажимаем OK и выбираем

в списке наименование Pin (вывод).

Нажимаем ЛКМ название примитива,

затем нажимаем на кнопку Edit Values.

Здесь надо изменить параметр Length
(длина вывода); устанавливаем зна�
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Рис. 2. Настройки текущего документа

Рис. 3. Настройки редактора схем



чение 4 мм и выходим из режима ре�

дактирования. Последнее, что необ�

ходимо в данной настройке, – вклю�

чить параметр Permanent, который

позволяет предохранять настройки

примитивов по умолчанию от пере�

записи.

После установки всех параметров

обратите внимание на список наст�

роек: у названия настройки появился

знак «*», а сама настройка выделена

жирным текстом, – всё это говорит о

том, что настройки изменены, но ещё

не сохранены. Чтобы применить но�

вые настройки, необходимо нажать

кнопку Apply и выйти из выпадающе�

го окна Preferences нажатием кнопки

ОК. Настройки, которые не были опи�

саны выше, не имеют определяюще�

го значения на начальной стадии ра�

боты с программой.

Перед созданием схемы подклю�

чим к листу форматку, которая была

заранее создана в виде заготовки и

содержит поля, автоматически за�

полняемые из свойств документа.

Для подключения форматки выпол�

ним Design > Template > Set Template
Name, после чего укажем форматку

(в нашем случае A3.SchDot, из до�

полнительных материалов на сайте

журнала) и нажмём кнопку ОК. На

экране появится окно, показанное

на рисунке 4, в котором необходимо

указать область применения фор�

матки и сообщить программе, как

поступать с новыми параметрами. В

нашем случае форматка применяет�

ся к текущему документу, и новые

параметры должны быть добавлены.

После нажатия кнопки ОК к листу

схемы будет добавлена форматка с

незаполненными полями (если это�

го не произошло, значит, размер

листа схемы меньше листа формат�

ки). Теперь, чтобы в полях формат�

ки появились соответствующие фа�

милии разработчика, проверяюще�

го и т.д., необходимо заполнить

карточку свойств документа, для че�

го выполняем Design > Document
Options. На вкладке Parameters в

строках Razrabotal, Proveril вместо

надписи в фигурных скобках запи�

сываются данные проекта, после че�

го эта информация появляется на

листе схемы.

РАЗРАБОТКА СХЕМЫ

В качестве примера создадим схе�

му, показанную на рисунке 5. Для раз�

работки схемы используется специ�

альная панель Libraries, посредством

которой выполняется работа с биб�

лиотеками. Запуск этой панели про�

изводится через меню вызова пане�

лей System > Libraries (правый ниж�

ний угол рабочего окна).

Компоненты

C1 EKAP
47
10

C2 C1206
1.0
20%

DD1 K511UP2

DD2 133LA6

L1 DR18

R1 R0805
4.7K
5%

R2 R0805
560
5%

R3 R0805
5.1
5%

VD1 KD510A_S

VT1 KT3102G

XP1 DRB
9RM_1

В запущенном виде панель Libraries
имеет вид, показанный на рисунке 6,

на котором также описано назначе�

ние окон данной панели. Перед нача�

лом работы необходимо подключить

библиотеки, в которых находятся

компоненты для создаваемой схемы.

Чтобы подключить библиотеки, на�

жимаем кнопку Libraries в одноимён�

ной панели, после чего на экране по�

явится окно, показанное на рисунке 7.

В данном окне имеются три вклад�

ки, их назначение следующее: Project –

библиотеки проекта, Installed – уста�

новленные библиотеки, SearchPath –

путь для поиска по библиотекам.

Предполагается, что библиотеки из�

начально были созданы в виде интег�

рированных библиотек (см. СЭ № 6,

2008), чтобы их использовать, эти

библиотеки необходимо добавить в

список на вкладке Installed. Для на�

шей схемы подключим библиотеку

Demo.IntLib (которую можно скачать

в Приложении к статье на интернет�

странице СЭ). Для подключения и

удаления библиотек используются

кнопки Install и Remove на вкладке

Installed в окне Avialable Libraries. По�

сле подключения библиотеки Demo
нажимаем кнопку Close, при этом па�

нель Libraries должна полностью со�

ответствовать показанной на рисун�

ке 6.
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Рис. 4. Обновление форматки

Рис. 6. Панель LibrariesРис. 5. Пример схемы
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Приступая к размещению компо�

нентов на листе схемы, не всегда

легко найти требуемый компонент

в указанных библиотеках, которые

могут содержать до нескольких ты�

сяч компонентов. Для поиска необ�

ходимого компонента в библиотеке

можно воспользоваться двумя мето�

дами. Во�первых, зайти в диалог по�

иска по кнопке Search панели

Libraries, что позволяет искать ком�

поненты по всем доступным библио�

текам, независимо от того, подклю�

чены они или нет (данная возмож�

ность не описывается в данной

статье). Во�вторых, воспользоваться

строкой поиска (см. рис. 6), где мож�

но написать название (или его часть)

необходимого компонента, исполь�

зуя специальные знаки (* – набор не�

определённых символов, ? – один не�

определённый символ). Например,

установим на схеме резистор R1 –

R0805�4.7K�5%, для чего в строке по�

иска введём текст «*4.7», после чего из

библиотеки будут извлечены компо�

ненты, содержащие в своём назва�

нии данные символы.

В панели Libraries будет показан

только один, необходимый нам ком�

понент. Выбираем с помощью мы�

ши данный компонент и нажимаем

кнопку Place. Указатель мыши прини�

мает вид крестика, к которому «при�

лип» контур символа резистора; это

означает, что редактор переключил�

ся в режим размещения. Прежде чем

щёлкнуть ЛКМ в поле схемы и поста�

вить резистор в необходимое место,

можно отредактировать его парамет�

ры, для чего следует нажать клавишу

Tab. В нашем случае свойства не из�

меняются, и компоненты размеща�

ются на листе схемы без конкретной

нумерации, которая будет автомати�

чески задана на последнем этапе ра�

боты со схемой. При размещении

компонентов следует обращать вни�

мание на сетку, которая должна быть

кратной 2,5 мм.

При размещении компонентов ис�

пользуется клавиши Space (пробел) –

поворот на 90 градусов – и кнопки X,

Y – зеркальное отображение относи�

тельно осей Y и X. Данные команды

отличаются от привычных настроек

P�CAD, что доставляет определённые

неудобства пользователям, имеющим

опыт работы с данной программой.

Для пользователей P�CAD существует

настройка, возвращающая комбина�

ции горячих клавиш к привычным,

«пикадовским»: View > Key Mappings >

> P�CAD.

После расположения всех компо�

нентов приступаем к прорисовке свя�

зей. Убедимся, что вся схема отобра�

жается в окне редактора схем, для че�

го выполним команду меню View > Fit
All Object. Сначала соединим нижний

вывод резистора R1 с эмиттером

транзистора VT1, выполнив команду

меню Place > Wire. Указатель мыши

примет вид крестика. Подведём ука�

затель мыши к нижнему выводу ре�

зистора R1. Появится красная звёз�

дочка, сигнализирующая о наличии

электрического объекта. Выполним

щелчок ЛКМ или нажмём клавишу

Enter, чтобы задать начало линии. В

программе Altium Designer преду�

смотрены четыре режима рисования

соединений: 90°, 45°, произвольный

угол и режим Auto Wire (соединяет две

выбранные точки по оптимальному

маршруту). Переключение между ре�

жимами осуществляется нажатием

комбинации клавиш Shift + Space. У

режимов 90° и 45° имеются по два

подрежима, переключение между ни�

ми осуществляется нажатием клави�

ши Space.

В целом эти и остальные элементы

рисования схемы не имеют принци�

пиальных отличий от аналогичных

программ редактирования такого

класса, поэтому далее будут перечис�

лены используемые команды с не�

большим комментарием, без подроб�

ного описания действий.

Команда Place > Bus Entry – выход

из шины; этот объект отсутствовал в

P�CAD, поскольку программа добав�

ляла вывод от шины автоматически;

Place > Bus – шина, в отличие от P�

CAD, не просто представляет собой

графическое изображение, а имеет

логическую сущность. Все цепи, объ�

единённые шиной на плате, будут вы�

рождены в класс цепей, поэтому ши�

на обязательно должна иметь назва�

ние, которое задаётся согласно

синтаксису: A[0. .2] – где A – метка наз�

вания, [0. .2] – разрядность шины

(максимальная цифра в разрядности

шины задаёт ограничение на количе�

ство входящих в неё цепей). Place >

Net Label – метка цепи; этой командой

задаются наименования цепей и

шин. Place > Power Port – установка

порта питания или земли. При уста�

новке всех объектов, описанных в

этом абзаце, следует нажимать клави�

шу Tab после вызова команды и зада�

вать необходимые атрибуты перед

установкой объектов на лист схемы.

Помимо рассмотренных объектов, на

схеме могут располагаться порты, со�

единители листов иерархических

проектов, метки правил и классов це�

пей, а также многие другие объекты,

которые будут описаны в одной из

следующих статей.

Последним этапом перед компиля�

цией проекта является автоматичес�

кая нумерация компонентов схемы,

которая в самом простом случае вы�

полняется командой Tools > Annotate
Schematic. В левом верхнем углу по�

явившегося окна задаётся направле�

ние нумерации (в нашем случае

Down then Across), после чего после�

довательно нажимаются кнопки

Update Changes List и Accept Changes.

Наконец, в окне Engineering Change
Order необходимо последовательно

нажать кнопки Validate Changes,

Execute Changes и Close, после чего во

всей схеме будет установлена авто�

матическая нумерация компонентов

в соответствии с отечественными

стандартами.

КОМПИЛЯЦИЯ ПРОЕКТА

Предположим, что схема создана

полностью, как показано на рисунке 5,

и сохранена. Следующим, концепту�

ально новым для разработчиков схем

на базе P�CAD этапом является компи�

ляция проекта. При реализации про�

екта печатной платы компиляция

обычно выполняется перед передачей

информации от принципиальной

электрической схемы в файл платы.

Если в программе P�CAD после разра�

ботки схемы необходимо было вы�

полнить проверку электрических

правил (ERC) и затем сформировать

список соединений (NetList), то в

программе Altium Designer выполня�

ется компиляция всего проекта, а за�

тем информация проекта передаётся

в файл платы выполнением одной ко�

манды. В связи с этим большую роль

играет процесс компиляции, который

выполняется для проектов всех типов,
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Рис. 7. Подключение библиотек



но в нашем случае будет рассмотрен

только для наиболее часто применяе�

мого проекта печатной платы.

Параметры проекта задаются на

странице, которая вызывается ко�

мандой Project > Project Options (при

этом должен быть выбран необходи�

мый проект или открыт один из его

документов). Данная страница содер�

жит несколько вкладок, на каждой

из которых задаются определённые

настройки (для проекта печатных

плат таких вкладок 10, см. рис. 8). Для

компиляции проекта, содержащего

только схему, достаточно установить

настройки двух вкладок Error Repor�
ting и Connection Matrix; рассмотрим

назначение каждой из этих вкладок.

Error reporting – отчёт об ошибках.

На данной вкладке представлен весь

перечень нарушений, которые могут

быть зафиксированы в проекте дан�

ного типа. Напротив каждого пункта

указывается степень важности дан�

ного нарушения для разработчика, и

могут быть выбраны следующие ва�

рианты:

● No Report – не включать в отчёт;

● Warning – предупреждение – нару�

шение фиксируется, но оно незна�

чительно;

● Error – ошибка, существенное нару�

шение;

● Fatal Error – критическая ошибка.

Все типы нарушений на вкладке

Error Reporting разбиты на группы,

относящиеся к определённому типу

объектов. Рассмотрим виды наруше�

ний, варианты их отображения и ре�

комендуемые настройки.

Прежде чем рассмотреть наруше�

ния разного типа, следует отметить,

что на начальном этапе можно вклю�

чить все виды нарушений, а затем,

анализируя полученные ошибки,

исключать те нарушения, которые не

актуальны для текущего проекта. Что�

бы установить уровень всех наруше�

ний, Error следует нажать правой

кнопкой мыши в любом месте окна и

выбрать All Error (см. рис. 8).

1. Violations Associated with Buses – пре�

дупреждения, связанные с шинами.

Здесь и далее на рисунке показаны

рекомендуемые настройки, а далее

по тексту описаны особенности на�

рушения и синтаксис сообщения,

которое будет отображаться при на�

рушении. Описание параметров

проекта проводилось по версии

программы 6.8, поэтому расшиф�

ровка некоторых нарушений отсут�

ствует. Кроме этого, не описывают�

ся ошибки, связанные с объектами

Harness и OpenBus, а также с кон�

фигурациями ПЛИС (Configuration
Constrains). Синтаксис нарушения

показан в фигурных скобках. В пер�

вой группе нарушений описывают�

ся ошибки, связанные с реализаци�

ей шин (см. рис. 8):

● Bus indices out of range – номер це�

пи выходит за пределы описанно�

го диапазона цепей шины: {Bus

index out of range on A Index = 4} –

в шине с меткой A имеется цепь

(A4), превышающая размерность

шины;

● Bus range syntaxes errors – нарушен

синтаксис описания диапазона ши�

ны: {Bus range syntax error NetName at

Location}, где NetName – некоррект�

ное название шины, Location – рас�

положение некорректной метки

шины. В общем случае шины долж�

ны иметь метку A[0…7] или A[7..0], в

которых буква задаёт имя шины, а

цифрами задаётся диапазон меток

цепей, которые в нее входят;

● Illegal bus definition – некорректное

использование шины; появляется

при подключении к шине объекта,

не относящегося к одному из разре�

шённых (netlabel, port, sheet entry,

pin, cross sheet connector или power

object);

● Illegal bus range value – некоррект�

ное описание диапазона цепей ши�

ны: {Illegal bus range value BusLabel

at Location}, где BusLabel – некорре�

ктная метка шины;

● Mismatched bus label ordering – пока�

зывает идентификаторы одной ши�

ны, ошибочно указывающие поря�

док возрастания номеров, напри�

мер, A[0. .2] и A[2. .0]: {Mismatched bus

ordering on NetName Low value first

and High value first};

● Mismatched bus widths – несовпаде�

ние ширины шины и названия пор�

та: {Mismatched bus widths on bus

section NetName (BusSize1 and Bus�

Size2)}, где NetName – несовпадаю�

щая метка шины, в скобках – разме�

ры шины и порта;

● Mismatched bus/wire object on wi�
re/bus – несовпадение типа иденти�

фикатора и названия цепи (шины).

Ошибка появляется в том случае,

когда шина заведена в порт (или

другой идентификатор), описыва�

ющий одиночную цепь: {Wire Port A

at 100mm, 100mm placed on a bus} –

ошибка свидетельствует, что порт А

(описывающий одиночную цепь)

подключен к шине. В общем случае

ошибка выглядит так: {ObjectIden�

tifier at Location placed on an Ob�

jectType}, где ObjectIdentifier – не�

корректная метка идентификатора

(вывод, порт, порт питания, вывод

листа, метка цепи), которая сопро�

вождается меткой, указывающей на

принадлежность к цепи (Wire) или

шине (Bus); Location – координаты

некорректного идентификатора,

ObjectType – объект, подключен�

ный к некорректному идентифика�

тору (цепь или шина);

● Mixed generic and numeric bus label�
ing – смешанная буквенно�цифро�

вая маркировка шины. Шины,

подключенные к одноименным

портам, имеют различное описа�

ние разрядности, например, A[0. .2]

и A[0. .b]: {Mismatched generic and

numeric bus labeling on NetName

Level value first and Generic}, где

NetName – некорректно описанная

метка шины.

2. Violations Associated with Compo�
nents – предупреждения, связанные

с компонентами (см. рис. 9):

● Component implementations with
invalid pins mappings – ошибка по�

является при компиляции интегри�

рованных библиотек и свидетель�

ствует о несовпадении количества
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Рис. 8. Предупреждения, связанные с шинами



выводов у символа и модели ком�

понента: {SN7432: Could not find

port 13 on model DIP14 for pin 13} –

у компонента SN7432 для вывода 13

не найден соответствующий кон�

такт на корпусе DIP14;

● Components containing duplicate sub�
parts – ошибка свидетельствует о

наличии нескольких одинаковых

ячеек одной и той же микросхемы.

Например, первая ячейка микро�

схемы SN7432 установлена в двух

местах с позиционным обозначе�

нием DD1.1: {Component Compo�

nentName has duplicate sub�parts at

Location1 and Location2};

● Components with duplicate pins – со�

общение свидетельствует о нали�

чии двух или более одноимённых

обозначений вывода компонента:

{Duplicate pins in component Pin

Identifier1 and Pin Identifier2};

● Duplicate part designators – продуб�

лированы позиционные обозначе�

ния компонентов на схеме (плате):

{Duplicate Component Designators

PartDesignator at Location1 and Lo�

cation2};

● Errors in component model parame�
ters – ошибка появляется при ком�

пиляции интегрированных библи�

отек и свидетельствует об отсут�

ствии описания модели одного или

нескольких выводов в IBIS�модели

для анализа целостности сигналов:

{ComponentName: Pin models could

not be found};

● Extra pin found in component display
mode – найден дополнительный

вывод в текущем режиме отображе�

ния компонента;

● Mismatched hidden pin connections –

сообщение свидетельствует о нали�

чии скрытых выводов у компонен�

тов и показывает цепи, к которым

по умолчанию подключены дан�

ные выводы;

● Mismatched pin visibility – несовпа�

дение названия цепи, подключен�

ной к выводу компонента, с назва�

нием цепи, к которой по умолча�

нию должен быть подключен

данный вывод в случае отсутствия

его отображения на схеме (такая

ошибка встречается при использо�

вании скрытых выводов земли и

питания);

● Missing components models – ошиб�

ка появляется при компиляции ин�

тегрированных библиотек и сви�

детельствует о наличии моделей

со ссылками на несуществующие

файлы библиотек либо на несуще�

ствующие модели в библиотеке;

● Missing components models in model
files – ошибка появляется при ком�

пиляции интегрированных библи�

отек и свидетельствует о наличии

отдельных файлов моделей (таких

как Spise и IBIS);

● Missing pin found in component dis�
play mode – найден не обозначен�

ный вывод в текущем режиме отоб�

ражения компонента;

● Sheet symbol with duplicate entries –

сообщение, свидетельствующее о

наличии двух одноимённых выво�

дов листа на одном символе листа;

● Un�designated parts requiring annota�
tion – сообщение, свидетельствую�

щее о наличии необозначенных

позиционных обозначений компо�

нентов (R?, D? и т.д.);

● Unused sub�part in component – со�

общение, показывающее не задей�

ствованные ячейки многосекцион�

ных компонентов.

3. Violations Associated with Configura�
tion Constrains – предупреждения,

связанные с ограничениями кон�

фигурации (см. рис. 10). Не описы�

ваются, т.к. относятся в большей

степени к реализации проектов

ПЛИС или совместных проектов

плат и ПЛИС.

4. Violations Associated with Documents –

предупреждения, связанные с доку�

ментами (см. рис. 11):

● Duplicate sheet symbol names – дан�

ное сообщение появляется, когда

на одном листе схемы повторяются

как минимум два обозначения сим�

волов листов;

● Missing child HDL entity for sheet sym�
bol – сообщение, показывающее

несопоставимые имена выводов на

символах листов и описание этих

выводов в подчинённом листе,

описанном на языке HDL;

● Missing child sheet for sheet symbol –

сообщение, показывающее несо�

поставимые имена выводов на сим�

волах листов и порты, соответству�

ющие этим выводам на подчинён�

ном листе схемы;

● Multiple top�level documents – сооб�

щение, появляющееся при компи�

ляции иерархического проекта;
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Рис. 9. Предупреждения, связанные с компонентами

Рис. 10. Предупреждения, связанные с ограничениями конфигурации

Рис. 11. Предупреждения, связанные с документами



свидетельствует о наличии двух

или более листов верхнего уровня;

● Port not linked to parent sheet symbol –

сообщение компилятора о нали�

чии порта на подчинённом листе

схемы, не имеющего ответной час�

ти на символе листа этой схемы на

верхнем уровне иерархии. Все вы�

воды на символах листов главной

схемы должны быть синхронизи�

рованы с соответствующими пор�

тами на подчинённых листах;

● Sheet entry not linked to child sheet –

сообщение компилятора о нали�

чии вывода листа на главном листе

схемы, не имеющего ответной час�

ти на одной из подчинённых схем;

● Unique identifiers errors – сообщение,

показывающее по меньшей мере два

компонента, листа схем или комби�

нацию этих объектов, имеющих оди�

наковые уникальные номера (ID).

5. Violations Associated with Harnesses –

предупреждения, связанные со жгу�

тами (см. рис. 12). Не рассматрива�

ются в данной статье. Если на схеме

не используются жгуты, то все на�

рушения данной группы можно

выключить из проверки.

6. Violations Associated with Nets – пре�

дупреждения, связанные с цепями

(см. рис. 13):

● Adding hidden net to sheet – добавление

скрытых выводов на листе схемы;

● Adding items from hidden net to net –

сообщение, показывающее цепи,

подключенные к выводам компо�

нента, которые изначально были

подключены через скрытые выво�

ды. Таким способом производит�

ся поиск несанкционированного

подключения цепей питания к ком�

поненту;

● Differential pair net connection polar�
ity inversed – соединение цепей

дифференциальной пары с различ�

ной полярностью;

● Differential pair net unconnected to
differential pair pin – отсутствие

подключение между цепями и вы�

водами дифференциальной пары;

● Differential pair net unproperly con�
nected to device – некорректное

подключение дифференциальной

пары к устройству;

● Missing negative net in differential pair –

отсутствует минусовая цепь в диф�

ференциальной паре;

● Missing positive net in differential pair –

отсутствует плюсовая цепь в диф�

ференциальной паре;

● Same net used in multiple differential
pairs – одна и та же цепь использу�

ется в нескольких дифференциаль�

ных парах;

● Duplicate nets – продублированы

названия цепей;

● Floating net labels – не подключен�

ные метки цепей;

● Floating power objects – не подклю�

ченные объекты питания;

● Net parameters with no name – безы�

мянные параметры цепи;

● Net parameters with no value – пара�

метры цепи, не имеющие значения;

● Nets containing floating input pins –

цепи, содержащие неподключен�

ный входной вывод;

● Nets containing multiple similar objects –

цепи, содержащие несколько про�

дублированных объектов;

● Nets with multiple names – цепь, со�

держащая несколько меток (назва�

ний);

● Nets with no driving source – цепь, не

имеющая источника возбуждения;

● Nets with only one pin – цепь, имею�

щая только один вывод;

● Sheets containing duplicate ports –

листы схемы содержат повторяю�

щиеся порты;

● Signals with multiple driver – сигнал

имеет несколько источников воз�

буждения;

● Signals with no driver – сигнал без

источника возбуждения;

● Signals with no load – сигнал без на�

грузки;
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Рис. 12. Предупреждения, связанные со жгутами

Рис. 13. Предупреждения, связанные с цепями

Рис. 14. Дополнительные правила

Рис. 15. Матрица соединений



● Unconnected object in net – не под�

ключенные объекты в цепи;

● Unconnected wires – не подключен�

ные окончания цепей.

7. Violations Associated with Others,
Violations Associated with Parameters –

предупреждения, связанные с пара�

метрами, и другие (см. рис. 14):

● Object not completely within sheet
boundaries – объекты, не пол�

ностью попадающие в границы

листа;

● Off�grid object – объекты, располо�

женные не в узлах сетки;

● Same parameter containing different
types – одинаковые параметры,

имеющие различный тип;

● Same parameter containing different
values – одинаковые параметры,

имеющие различные значения.

Многие из рассмотренных настро�

ек могут изменяться для различных

проектов, и большую роль здесь игра�

ет использование шин, жгутов, пор�

тов и других вспомогательных эле�

ментов.

Connection Matrix – матрица соеди�

нений (см. рис. 15). На второй вкладке

параметров проекта показана матри�

ца соединений, в которой по горизон�

тали и вертикали перечислены все

возможные типы выводов, портов и

выводов листа. Данная матрица задаёт

уровень значимости подключений

каждого типа. Например, по умолча�

нию на пересечении строки и столбца

Input Port установлено значение Error,

– это свидетельствует о том, что одна

цепь не может содержать два и более

входных порта, но для многих схем

это является нормальным! Следова�

тельно, в данной матрице необходимо

описать пересечения всех типов.

Настоящая статья написана по ма�

териалам справочного руководства

Altium Designer, которое находится в

папке Help директории установки

программы. Для подробного знаком�

ства с настройками компиляции

проекта рекомендуется прочитать

статью TR0142 Project Compiler Error

Reference.pdf, находящуюся в папке

документации Altium Designer\Help.

После настройки параметров ком�

пиляции согласно установкам на ри�

сунках 8 – 14 можно выполнять ком�

пиляцию проекта и его отладку (при

наличии ошибок). Запустим компи�

ляцию командой Project > Compile
PCB Project. Результатом станет появ�

ление окна Messages с ошибками про�

екта. Если проект был выполнен в со�

ответствии с рисунком 4, то в списке

сообщений будет две ошибки и не�

сколько десятков предупреждений

(см. рис. 16).

После компиляции начинается

один из наиболее сложных этапов

работы с программой – отладка схе�

мы. Необходимо добиться, чтобы в

списке нарушений (Messages) не со�

держалось ни одной ошибки (Error и

Fatal Error); наличие предупрежде�

ний некритично. Отладку рекоменду�

ется выполнять поэтапно: сначала из�

бавиться от одной ошибки, затем

снова провести компиляцию и толь�

ко после этого переходить к следую�

щей ошибке.

Вернёмся к рассматриваемой схе�

ме. Выполним двойной щелчок ЛКМ

на первой ошибке. В результате на

экране появится окно Compile
Errors, в котором приведён текст

данной ошибки (в нашем случае

указана цепь А6, которая имеет

только один вывод). Поскольку ре�

шение проблемы не очевидно, пе�

рейдём ко второй ошибке. При вы�

делении второй ошибки сообщает�

ся, что существует некоторая цепь,

содержащая только один вывод, от�

куда становится понятно, что на

этой цепи не хватает метки (цепь

входит в шину и при этом не имеет

метку цепи). Выполним команду

Place > Net Label и установим метку

А6 на эту цепь. После проведения

компиляции окно нарушений не бу�

дет содержать ошибок.

Теперь мы имеем проект, содержа�

щий одну схему и готовый к передаче

информации на печатную плату, о

разработке которой будет рассказано

в следующих статьях.
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Рис. 16. Список нарушений

Canon запатентовала
DSLR$камеру с топливным
элементом

Одними из наиболее вероятных канди-

датов на роль «убийцы аккумуляторов»

для портативной электроники являются

так называемые топливные элементы, ко-

торые уже прописались в таких устрой-

ствах, как мобильные компьютеры и теле-

фоны. Но пока дело дошло только лишь до

инженерных образцов, и в серию такие ап-

параты до сих пор не попали. Остаётся не-

известной судьба и ещё одного типа элект-

ронных устройств, питание которого может

осуществлять топливный элемент, – циф-

ровых фотоаппаратов. С одной стороны,

причин для оптимизма пока нет, ведь

технология явно не отработана до реаль-

ного коммерческого использования; с

другой стороны, компания Canon запа-

тентовала конструкцию цифровой «зер-

калки», оснащённой именно топливным

элементом.

Необходимо заметить, что слухи о сот-

рудничестве одного из лидеров в разра-

ботке новых элементов питания, компа-

нии MIT, с неизвестным на тот момент

производителем цифровых фотоаппара-

тов уже появлялись в Сети. А новая ин-

формация о получении Canon патента на

«топливную» зеркальную камеру только

подтверждает неофициальные сведения.

Разумеется, пока рано говорить о ско-

ром выпуске на мировой рынок столь ин-

тересного аппарата – по всей видимости,

Canon заранее позаботилась о своём бу-

дущем, ведь в случае доведения техноло-

гии топливных элементов до коммерчес-

кого уровня конкуренты вполне могли

первыми зарегистрировать свое «изобре-

тение», что значительно осложнило бы

вывод новой продукции в продажу. Те-

перь же компания имеет полное право

выпускать собственные «топливные» фо-

тоаппараты на мировой рынок, а заодно и

продавать лицензию сторонним произво-

дителям.
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